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Overview

This article walks through the steps to create a giving history report. This particular report is year-by-year, but you could just as well filter yours
month-by-month, week-by-week, etc.

This article is primarily for nonprofit customers, but political customers can use this same technique to create filtered columns by election, date
range, event, among other things.

« Tip: If you prefer a video walk-through, click here.
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Steps

Navigate to your Contacts (Voters/Donors) list.
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—— —_—
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EBo
Tasks

- & Calendar/Tasks
=By Contact

I:Dmagts h
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(-4 Contributions/Pledges
I:II*:; Product Sales

w-<2> Logs

-2 Communications

#-¢i Financial

- %y System Manager

(|

Run your search query, then click the [Format] drop-down, and select Columns. In my example | searched for all individual donors in the database,
which populated 1,412 records.
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Build and run your search query, then click on the Format drop-down, and select ‘Columns’.

I13) Trail Blazer Version 6

B) Settings  Help

Application Menu <<l <5 Search [ Reset | < New 09 L) ¥ | File » Edit - | ) | §pInclude Other | Contacts
ERO
Tasks . s ; )
Favortes | 4 General | Address | Household | Attibute | Canvass A Cortribute Pledge | Event | Log Admin | SQL

o £ Dashbosrd | | | | | | | | Pledge | Event | Log | Admin | saL |
- § Calendar/Tasks 4 Cortribute | Marketing Notion
[#- % Canvassing

@3 Contacts <custom, according to dates below: - [ Awaiting Thank-You Letters

@j Addresses ~ Date Range: | |’|:| gito ||:| g{ .

@ Howseholde Awaiting Thank-You Phene Call

..[8[] Cortact Relationships Cyele: Agnore> |Z| Payment Method:

..~ Contributions/Pledges Event. <ignore> [] Single Contribution

Amount Range:  minimum * to  madmum - Miocstion Fund:

¢ Exclude | B Sort [ Format -|| “7% Export (< Print || Detail @ Summary [[] = | & Pivot

<System Format>

/ C:nhds[lmlmm]

Query results

|@ Celumns...

Home Phone
E’ Select saved...

(612)920-9217 ||| Martha@Aagard com

4 Aakhus Gng( II Save T orEre T el (218) 828-9215

7 Aanenson Pamela h@ Save As.. 6 White Bear Ave White Bear Lake | MM 55110 {651) 426-9611 Pamela@Aanenson.com
) Abbott Gina . 13 Concord Ave Edina MN 55424 (952) 5299217

- - @ Assign as default... - - - -

1 Abdi Ali 62nd 5t W Apt 403 Minneapolis MN 55419 (612) 432-3920 Ali@Abdi.com

14 Abdulali Quaid Home 3408 Stevens Ave 5 Apt 5 Minneapolis MM hh408 (612) 821-53310

19 Abrahamian Danigl Paul Home 6012 Beard Ave 5 Edina MM 55410 (952) 3299918 Daniel @Abrahamian.com
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Scroll down the right-hand list of columns and check the ‘ContributionTotalUser’ column(s). Check as many columns as you want to filter by i.e. if |
was going to filter by 6 years, which | do in this example, | would check all six of the boxes.
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€Y Column Selection

Columns FH; &35 | Fomat

Table Columns [Contacts]

% I =z [ ContributionTotalForeign
==

ContributionTotal ForEvent
ContributionTotal MextCycle
ContributionTotal PrevicusCycle
ContributionTotal SoftCredit
ContributionTotal ThisPeriod

ContributionTotal User(1
les ContributionTotalUser02
= Contacts I ContributionTotal Userl3
) User H ContributionTotal User(4

) Address [DefauttDisplay] ContributionTotal User05

/ ContributionTotal UserDE

EI@ Address [Home]

ContributionTotalVeterDerivationCustom(2
) Address [Mailing] ContributionTotalVeterDerivationCustom03

P Addrese [Renistetin] / Contribution TotalYearThruPericdEnd
Progress /
|

Select the "ContributionTotalUser"
columns for as many columns you
want to filter by.
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Navigate to the Format tab, and click the first ‘Filter’ hyperlink to begin filtering that virtual contribution column.
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&) Column Selection

Column Heading Fitter Visible Width  Frozen  Updatable -

Phone_Cel Cell Phone

Email Address Email

Employer Employer/Compary Name
Contribution Total User(1 Cortribution Total User(1
Contribution Total User02 Contribution Total User(2
Contribution Total User03 Contribution Total
Contribution Total User(4 Contribution Total
Contribution Total UserD5 Cortribution Total
Contribution Total User(é

T T O
T L e BN e T e TR e TR N )

=== == = E
) T

1|

/
/

Fi

/
Click the first filter link to begin filtering

by that column. ORT:
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Enter the date range you want to filter by, and click [OK]. In this example | filtered by the last 6 years, so | started with 1/1/2010 - 12/31/2010.
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Enter your custom date range to filter by.

@ Column Selection

| Columns | Attributes | Fomat |
Format ! Filter "Cogtribution Total User01™ Column

Column : Frozen  Updatable -

Phone_Cell :
Email Addresg

Employer _
| '

Contribution T Custom SQL fitker {provided by Trail Blazer for special cases) =
Contribution T T naza E E] B
ContributionT F - - X3 C]
ContributionT =

Contribution T ]

E—

10
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Repeat these steps for each of the “filter’ hyperlinks. Once you complete that, you’ll want to double-click in each of the ‘Heading’ cells to rename
those column headers. My example is below.
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Repeat the previous steps to filter each of the
'‘ContributionTotalUser' columns for each of the date
ranges that you need.

@ Column Selection

| Columns | Attibutes | Fomat |
Format

-

Column Heading Fitter Visible Width  Frozen  Updatable -

Phone_Cell Cell Phone

Email Address Email

Emplayer Employer/Company Name .,
Contribution Tatal User(1 Contribution Total 2010
Contribution Tetal User02 ﬁ Contribution Total 2011
Contribution Tatal User03 / Contribution Total 2012
Cortribution Total User04 Contribution Total 2013
Contribution Total User] Contribution Total 2014
Cortribution TotalUss 06 Contribution Tetal 2015

Ew

o
o

8888

<] <= =) == ==

12

Double-click in the green ‘Heading' cells to

. | ey A B Y ey
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Click [OK] to add those columns into the grid. By default they will display on the far right, you’ll need to click [Search] to refresh the values with
the correct counts. My example is below.
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=3¢ Search Reset | 4 New 0 | ) ¥ & | File - Edit - | 0 |85 Include Other Contacts |
Click [Search] f ,
to refresh the Favortes | . General | Address | Housshold | Attioute [ Canvass | # Cortribute | Pledge | Event [ Log [ Admin [ saL |

counts in the Z Name | Prone | E-Mai | Email Links | Profie [ Work | Demogmphics | User, Text [ User, Dates | User, Decmal | other |
filtered columns.

Q
Individual Last Name - ool e s Title:
Corparation First/Org Name: ~  (anywhere in field) Suffixc: hd
Foundation Middle Name: L —
Nickname:
Prior Last Name:

New filtered columns display here, with
totals at the bottom. \

§§ Edit | % Include %% Exclude @Sor‘t @Format - REExport &Prmt

ontacts ecords found

Incl 1D Ilfasn:e E:_Ie _i_.»\dy:;ess Address mir\;ss City State g:de ;‘:::e Email glrg'ibmion gl‘gﬁbmion g:ﬂzribl.rtion glrﬂ'ibmion glr:'ibmion g:f:'ibl.ltion
Total Total Total Total Total Total
(3 gard 1 (0 gard 00 0.00 00.00 00 00 00
4 Aakhus Cindy Home 19981 See Gull Rd Brainerd MN 56401 |(218) 8289215 25.00 120.00 00 00 00 00
7 Aanenson Pamela Home 3896 White Bear Ave White Bear Lake | MN 55110 | (651)426-9611 | Pamela@Aanenson.com 230.00 250.00 00 00 .00 .00
E] Abbott Gina Home 5533 Concord Ave Edina MN 55424 | (952) 9299217 00 50.00 00 00 00 00
11 | Abdi Al Home 206 62nd St W Apt 403 Minneapolis MN 55415 | (612)432-8320 | Ali@Abdicom 200.00 220.00 00 0o 00 .00
14 Abdulali Quaid Home 3408 Stevens Ave S Apt 5 Minneapalis MN h5408 | (612)821-9310 1,000.00 1,000.00 00 0o (1] 00
19 Abrahamian | Daniel Home 6012 Beard Ave 5 Edina MM 55410 | (952) 9295918 | Daniel@Abrahamian.com .00 4,150.00 00 00 .00 .00
2 Acaso Jonathan Home 3347 Irving Ave N Minneapalis MN ha412 | (612)529-5013 (1] (1] 300.00 0o (1] 00
25 | Adair Geraldine Home 27058 Tucker Td NE Isanti MN 55040 | (763) 441-7437 00 3.480.00 200.00 0o 00 .00
36 Adams Elizabeth Home 634 Frankdin St Apt B306-4 | Winana MN h5987 | (647) 832-8621 1,000.00 1,000.00 00 0o (1] 00
44 | Ades Amold Home 4566 Clearwater Td Apt 1 Lonsdale MN 55046 | (507) 744-7633 00 3.520.00 00 0o 00 .00
46 | Adolph Mildred Home 650 Hudson St Paynesville MN 56362 | (320) 243-7131 250.00 290.00 00 00 00 .00
55 Ahlgren Suzanne Home 4864 14Ah Ct Savage MM 55378 | (952) 440-7530 .00 .00 .00 00 .00 .00
58 Ahn Jung Home 1600 Westview Dr Hastings MN 55033 | (6571)437-8325 |Jung@Ahn.com 250.00 .00 250.00 00 .00 .00
73 Adams Manette Home 560 Ballantyne Ln NE Spring Lake Park | CT 06500 | (651)336-8728 | Manette@Adams.com .00 .00 00 00 .00 .00
84 Ali Kadigia Home 3933 Bth Ave 5 Minneapalis MN 55409 | (612) 7299111 |Kadigia@Ali.com .00 1.260.00 00 00 .00 .00
&7 Al Sahra Home 1515 Park Ave Apt 1306 Minneapolis MN hadld | (612)3383-8823 .00 1,340.00 00 00 .00 .00
28 Ali Zuffigar Home 7633 Everest Ln N Maple Grove MN 54311 (763) 420-9810 | Zulfigar@Ali.com .00 .00 00 00 .00 .00
54 Almann Chiistine Home 183 Malcolm Ave SE Minneapolis MN 553414 | (612)331-8321 | Christine@Allmann.com .00 5.480.00 00 00 .00 .00
56 | Allore Kim Home 15 Camden Ct North Mankato MN 56003 | (507) 6259313 00 00 00 00 00 .00
99 | Atendofer | Greg Home 2355 Bevery Rd 5t Paul MN 55104 | (651) 644-7438 00 1.430.00 00 0o 00 .00
100 | Ato Bradley Home 3301 State Hwy No 169 Apt 332 Plymouth MN 55441 | (218) 741-7232 00 15.00 00 00 00 .00
112 | Amundson Eugene Home 7218 Robinwood Draw Woodbury MN 55125 | (651) 7388321 | Eugene®@Amundson.com .00 3.330.00 00 00 .00 .00
122 | Anderson Antoinette Home 13505 Maple Grove Rd Pine City MK 55063 | (320) 2235311 | Antoinette @Anderson.com .00 .00 00 00 .00 .00
127 | Anderson Brandon Home 15106 Yellow Pine St NW Andover MN 55304 | (763)434-8624 | Brandon@Anderson.com .00 1,650.00 00 (i .00 .00
[ 130 4 Deccd Ll 1E10C Vol i, St BIVAY N, BAKI EEINA ATLN AT Q0T L. 4 nn O30 00 00 nn 00 nn
314 37604632 | 270087100 15242841 00| 15239066 32.565.00
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If the report is formatted the way you prefer then you’ll want to save it for future use, so you or other database users don’t have to rebuild it each
time.

Click the Format drop-down and select Save As...
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s Search %, Reset | <k New 0= L) CF (b | File  Edit + | o  SpInclude Other | Contacts
9

Faverites | 4% General | Address | Household | Attribute | Canvass | . Contribute | Pledge | Evert | Log | Admin | SaL |

Z Name | Phone | E-Mail | Email Links | Profie | Work | Demographics | User, Text | User, Dates | User, Decimal | Other |
@ 1
Individual Lazt Mame: - Title:
) ) Search all name parts Suffix
Corporation First/Org Name: ¥ [(anywhere in field) i -
Foundstion Middle Name: -
Mickname:
Prior Last Name:
i
P

o

=8 Edi - || B i i =l Pi
.:E Edit | % Include % Exclude @Sor’c @Format EE:(port &Prmt Detall [@] Surnmary D:I E Pwot |
Contacts [ 1412 records found | <System Format>

@ Columns...

2010 201

nd D 2 e B Selectsaved. pddess oy Sae 2P pome Emai Cortnsion  Cortutin
(B |2 [Asgad Martha Cave I [T — MN (55410 [(612)920-9217 |Martha@Aagard.com 00 270.00 |
4 Aakchus Cindy |‘B Save As... | Brainerd MN 56401 | (218) B28-5215 25.00 120,00 |
7 | Asnenson | Pamela ' ' White Bear Lake | MN | 55110 | (651) 4269611 | Pamela@Aanenson com 230.00 250.00 |
9 Abbott Gina @ Assign as default... . Edina 1wy 55424 |(952) 9299217 o0 90.00 |
1 Abdi A Home 306 62nd SLW | Save the current format under a specified name l15 (612)432-8920 | Ai@Pbdi com 200.00 220,00 |
14 Abdulali Quaid Home 3408 Stevens Ave 5 AptH Minneapolis MM 55408 | (612) 8219310 1.000.00 1,000.00 |
15 Abrahamian | Daniel Home 6012 Beard Ave S Edina MN 55410 | (952) 9299918 | Daniel@Abrahamian.com 00 4.190.00 |
24 Acaso Jonathan Home 3347 Irving Ave N Minneapolis MM bed12 | (612) 5295013 00 00 |
29 | Adair Geraldine Home 27058 Tucker Td NE lzarti MN 55040 | (763) 441-7437 00 3.480.00 |
36 Adams Elizabeth Home 634 Franidin St Apt B3D6-4 | Winona MN 55887 | (641) B32-8621 1.000.00 1,000 .00 |
44 | Ades Amold Home | 4566 Clearwater Td Apt 1 Lonsdale MN | 55046 | (507) 7447633 00 352000 |
46 Adolph Mildred Home 650 Hudson St Paynesville MN h6362 | (320) 243- 7131 250.00 290.00 |
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Create a relevant name for the format and click [Save]. I called mine “Giving History (Year x Year 2011 — 2015)”.

@ Save Format

MName: Giving History (Year x Year 2011-2015) - I 1

[TEr, 472472015 (JAK) Format .
@Eﬂntrib Amt w contacdt info
B} Household Contributions

) Test 1

P test with updateable fields

2

| Save | [@ Cancel ]

This completes the steps.

If you need to load up the saved format you created, or assign it as a default, you can do that here:
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9

<3 Search % Reset | 4b New 0= L) O @ | File - Edit + | ) | §gInclude Other | Contacts

| Favortes | /* General | Address | Household | Attribute | Canvass | #* Contribute | Pledge | Event | Log | Admin | SQL |

#* Contribute | Marketing Notion

L )

~ Date Range: |

[ om, according to dates belows T] Aziting Thank-"You Letters

O Bie O B [ Awaiting Thank-You Phone Call

Cycle: <ignore:

E Payment Method: |=ﬂgnure:=- |z||

Bvent: <ignaore

E [7] Single Contribution

Amount Range: i t i
i nge:  minimum + to  madmum - Al on Fund: |-:jgr1ure:=- |z”

Load your saved format.

Contacts [ 1412 records found ]

Last Fi
Inel 1D & Title Name

[}

Aakhus
Aanenson
Abbott

|: 1683 {1=ad | 1=

I_Iil_lﬁl_

SEEdit | % Include % Exclude | Sort | Format || &% Export % Print etail (@l summary [[] = |[E Pivot

=System Format>

Columns...
ress

Sel d... R —
sectsave I Yok Ave S |[Minneapolis  |MN [55410 [

Save 31 See Gull Rd Brainerd
Save Az, 3 White Bear Ave || White Bear L... [ MN | 55110
} Concord Ave Edina

Minneapolis

Assign as default..
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If you need to print or export the report you can do that here:
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<o Search %, Reset | New |[S|E = | ) ¥ ¢ | File - Edit - | & | GpInclude Other | Contacts

Q

| Favorites | 4% General | Address | Household | Attribute | Canvass | #* Contribute | Pledge | Event | Log | Admin | SQL |

#* Contribute | Marketing Notion

® QD

~ Date Range:

[m;st::m according to dates below:> v] Aawaiting Thank-You Letters
O Bir O B [ Awaiting Thank-You Phone Call
Cyele: <ignore> ﬂ Fayment Method: | <ignore: |z||

Event: <ignaore E Single Contribution
Amount Range:  minimum ¥ |0 | mzdmum T Mllocation Fund: |dgnure> |E||

=8 Edi & i & = Pi
S8 Edit | % Include % Exclude | Sort B Format X Export ¢ Print [m Summary [[] = |[E Pivot |

Contacts [ 1412 records found ]

Last First Address Address £ip Home
MName Mame Type Address Line 2 City State Code Phone

2 Aagard Martha 4629 York Ave 5 Minneapaolis MM o410 (612 920-5217
I_I—Iilili Iil—l—li

Aakhus 155981 See Gull Rd Brainerd {218) 828-5215
Aanenson 3856 White Bear Ave White Bear Lake (651) 426-9611

Incl 1D
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Here’s an example screenshot of the last page of my finished report:
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Example Print Preview of a Giving History Report

&Print poy= EE Less 88 More 0 Q Ell Q 0 (jPrint Settings
Contacts [ 1412 records found ] Date/Time: 10/28/2015 12:28 PM Page: 31
Last Name  First Name City State Home Phone 2010 2011 2012 2013 2014 2015
Contribution Contribution Contribution Contribution Centributi... Contribution
Total Total Total Total Total Total
Wofse Abe Minneapolis MN (612) 220-9812 .00 2,270.00 .00 .00 .00 .00
Wold Christian St Louis Park N (612) 730-8125 .00 2,280.00 .00 .00 .00 .00
Wolf Carla Woodbury N (651) 730-8327 .00 2,790.00 .00 .00 .00 .00
Wolowidnyk Raymond Winnepeg MB (231) 321-3213 275.00 280.00 .00 .00 .00 .00
Wood Joann Grand Rapids N (218) 327-9115 .00 .00 750.00 .00 .00 .00
Wood Willard Faribault MN (507) 332-8621 .00 2,290.00 .00 .00 .00 .00
Woog Kristan Hastings MN (651) 428-9111 .00 .00 .00 .00 .00 .00
Woolverton  Jeffrey Duluth N (121) 321-3213 .00 .00 1,100.00 .00 .00 .00
Wosmek Laura Minneapolis MM (612) 927-9915 .00 5,730.00 .00 .00 .00 .00
Xiomara C... Natalia St Charles CT (507) 932-8425 .00 .00 .00 .00 .00 .00
Xiong Cheng Brooklyn Park N (763) 425-9116 .00 5,780.00 .00 .00 .00 .00
‘Yager Mary Sauk Rapids CT (320) 529-9218 .00 2,300.00 .00 .00 .00 .00
Yang Nan New Brighton N (651) 639-8929 .00 3,750.00 .00 .00 .00 .00
Yang Xong St Paul N (651) 335-8120 .00 2,880.00 .00 .00 .00 .00
‘Yarosh David St Louis Park MN (952) 928-9315 .00 5,230.00 .00 .00 .00 .00
Yeates Peg Visalia CT (555) 555-5555 225.00 275.00 100.00 .00 .00 .00
Yerman Tara Golden Valley CT (763) 529-9112 .00 2,310.00 .00 .00 .00 .00
Yokiel Laura Edina N (952) 929-9517 740.00 .00 .00 .00 .00 .00
Young Deborah Eden Prairie N (952) 937-8522 .00 1,990.00 .00 .00 .00 .00
Young Kaitlin Circle Pines VN (763) 923-9014 .00 .00 .00 .00 .00 .00
Young Paul Hastings N (651) 438-8624 .00 2,530.00 .00 .00 .00 .00
Yurek Rustina Minneapolis N (612) 245-7639 .00 1,610.00 .00 .00 .00 .00
Zaeska Jaymi Willmar MN (320) 235-8725 .00 2,600.00 .00 .00 .00 .00
Zahrbock Stephanie Edina N (952) 922-8405 5,000.00 5,170.00 80.00 .00 .00 .00
Zallek Nancy St Peter CT (507) 931-2316 250.00 280.00 .00 .00 .00 .00
Zayarni Vlaol Maple Grove CT (763) 531-8324 .00 3,160.00 .00 .00 .00 .00
Zbaracki Julie St Paul MN (651) 290-2807 125.00 130.00 .00 .00 .00 .00
Zeilinger Nicole Bemidiji MN (651) 343-7330 .00 4,060.00 .00 .00 .00 .00
Zellmer Lisa Edina MN (952) 915-1195 500.00 6,260.00 .00 .00 .00 .00
Zuraw Thomas Lakeville CT (952) 236-8221 .00 2,700.00 .00 .00 .00 .00
Zweber Greg Na NB 500.00 500.00 .00 .00 .00 .00
Kristenson Joel Golden Valley N (218) 442-1919 .00 .00 .00 .00 147 570.66 32,565.00
376,046.32  2,700,871.00 152,428 41 .00  152,380.66 32,565.00
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The related resources below link to many other relevant articles/videos, that will help teach you how to fully utilize the formatting tools in your
database.

2%

igs

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

Article: Creating and Saving Default Formats for Reporting with the Grid
Article: Add Attributes, Attribute Dates, and Attribute Notes to the Grid by Formatting them in as Columns
Article: Creating Formats for Custom Views and Editing of Your Data

Article: Creating Formats
Article: Walk List — Selectable Format
Video: Filtered Contribution Columns in Format

Video: Filter Using New Date Controls
Video: Attributes — Add attribute dates and notes to your list

Trail Blazer Live Support

KNOWLEDGE BASE www.trailblz.com/kb 24



http://www.trailblz.com/kb
http://trailblz.com/kb/?action=view&kb=272&cat=1
http://trailblz.com/kb/?action=view&kb=271&cat=1
http://trailblz.com/kb/?action=view&kb=50&cat=1
http://trailblz.com/kb/?action=view&kb=33&cat=1
http://trailblz.com/kb/?action=view&kb=192&cat=1
https://www.youtube.com/watch?v=JAWAtubEcDU
https://www.youtube.com/watch?v=DcdB1BKOF7A
https://www.youtube.com/watch?v=S16BGqO6HvM

& TrailBlazer

Organize, Leverage. Succeed.

How to Create a Year-by-Year Giving History Report Using
Filtered Contribution Columns in the Grid - Primarily for Nonprofits

© Phone: 1-866-909-8700
® Email: support@trailblz.com

E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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